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1.Introduction
CNC Transfer is designed to allow a standard PC to communicate with any CNC machine 
that has a serial interface. The program allows you to store files in a structured way as 
well as giving you the editing facilities of a text editor. Before using the program it is 
recommended that you read through these instructions.

1.1Installation
To install CNC Transfer put the installation disc in drive A then select Run from the Start 
menu. Type the following and then press enter:

A:\CNCSETUP.EXE

1.2Running
To run the program, open the Start Menu, go to Programs and select CNC Transfer from 
the folder of the same name.

1.3Registration
To enable the registered version of CNC Transfer go to the Help menu and select 
Registration. A dialogue box will appear, in this box you will need to enter your 
Registration Name and Key, then click OK. If you have correctly entered the details then 
you will have full access to CNC Transfer, if not then check that you have typed your 
details exactly as supplied.

2.Using CNC Transfer
2.1Setting up the Program
When you first run the program you will be asked for the location of a data directory, 
enter an appropriate pathname for the location you wish to store your files in. After a short 
delay the main window should now appear.

Before CNC Transfer can be used it must be correctly setup. Use the Edit Customers 
dialogue box (see below) to add the names of all the customers that you wish to store 
programs for. Using the information provided in their technical manuals, use the Edit 
CNCs dialogue box (see below) to add each of the CNC machines that will be used with 
the program. You should test that you have entered the correct settings by using the 
Receive and the Send menu options (see below).
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2.2Using the Program

When CNC Transfer is loaded a black editor window will be displayed. Along the top of 
the window is the title bar this displays the name of the current file being edited. Below 
the title bar is the menu bar, it allows the user access to all of CNC Transfers functions. 
Each set of functions is grouped together on one menu. To access a menu simply click on 
the name (or press Alt and the underscored letter). Below this is the toolbar this gives fast 
access to the most commonly used functions by clicking the buttons.

2.3File Menu
The File Menu consists of the following options (some may be greyed):
1. Open
2. Save
3. Save As
4. Clear
5. Delete
6. Find
7. Move
8. Import
9. Export
10. Print
11. Print Program Index
12. Print CNC Index
13. Print Setup
14. Edit Customers
15. Exit

5



Rank Brothers Ltd
2.3.1Open

This option allows you to open a previously saved file. When the option is selected the 
Open Program dialogue box will appear. This dialogue contains a box labelled Customer 
Name, clicking on one of the names will display a list of programs underneath the 
Program Name box (if nothing appears it means that there are no programs saved under 
that customer name). Now select one of the program names and click on the OK button, 
the selected program will be loaded into the editor. 
If there is a long list of program names you can save time by entering part of the name in 
the Program Name box and pressing enter, only programs containing this text will be 
displayed. As usual clicking on Cancel will remove the dialogue box without loading any 
files.

2.3.2Save
This option will save any changes made in the editor or the Header dialogue box. If you 
are working on an untitled program (for example after using the Import menu item) then 
the Save As dialogue box will be displayed.

2.3.3Save As
The Save As dialogue has two uses, firstly if you are working on an untitled program then 
this dialogue box will allow you to save the file with a customer name (selected from the 
Customer Name box) and a program name. If you want to save your untitled work over 
the top of an existing program you can select the customer name as normal then choose 
the program name from the list.

The second use for the Save As dialogue box is for copying a file to another customer. 
Firstly open the file which you wish to copy to another customer, now choose the Save As 
option. Select the new customer name from the list then click on OK, the file in the editor 
will be copied to the new position.

2.3.4Clear
This option clears the editor window.
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2.3.5Delete
This option works in the same way as the Open Program box except that the selected file 
will be deleted instead of opened. A warning box appears asking you to confirm your 
choice. Be careful as deleting a file is irreversible.

2.3.6Find
This option allows you to find a file without having to know which customer it is stored 
under. Enter part of the name in the Program Name box and then click on the OK button. 
A list of programs containing the text you entered will be displayed. Clicking on these 
programs will display which customer they belong to in the Customer Name box. Clicking 
on OK will open the currently selected program into the editor.

2.3.7Move
This option allows you to move programs from one customer to another. Select the 
customer and then the program name in the From part of the box. Then select the 
customer in the To part of the box, when you are satisfied with the choices you have made 
click on the OK button to move the program. If you change your mind click on the Cancel 
button to close the box without moving any programs.

2.3.8Import
This option allows you to import an external file containing a program into CNC Transfer. 
A file dialogue box will show, use this to find the file you wish to import and then click 
on the OK button. Once you have imported a file it will open in the editor, you can then 
save it using the Save command (see above).

2.3.9Export
This option allows you to export a program in CNC Transfer to a text file. Use the file box 
to select where you wish to export the program to and enter a filename then click the OK 
button. You will be asked whether you wish to remove encoding data from the program, 
selecting Yes will make the exported file easier to read in a standard text editor but may 
cause problems when re-importing. Selecting No will export the file in the exact format 
that it was received in.

2.3.10Print
The Print option will send the contents of the Header dialogue box and the editor to the 
current printer. Before the program prints you will be asked to confirm that you wish to 
print, do so by clicking on the button labelled Yes.

2.3.11Print Program Index
This option opens the Print Program Index dialogue box, it allows you to print indexes of 
customers and the programs associated with them. You can select whether to print all 
customers or a selection. If you choose to print only a selection then a list of all the 
customers will appear. You can select customers by clicking on them and can deselect 
them by clicking a second time. The Each customer on new page option starts at the top of 
a sheet of paper for each customer. When you are happy with your choices then click OK 
to print the program index.
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2.3.12Print CNC Index
The Print CNC Index option prints a list of each CNC and the options associated with that 
machine. As with the Print option you will be asked to confirm before the printing begins.

2.3.13Print Setup
This option brings up a standard Windows Print Setup box allowing you to choose which 
printer to print to and the paper size to use. Click on the OK button to make the changes or 
the Cancel button to forget the changes made.

2.3.14Edit Customers
This option brings up the Edit Customer dialogue box that allows you to add, edit and 
delete customers. To remove the Edit Customer dialogue box from the screen click on the 
Close button.

To add a customer, click on the Add button then enter the name of the new customer. 
When you have entered it click on OK to accept or Cancel to close without adding the 
customer to the list.

To edit a customer select a name and then click on the Edit button, edit the name exactly 
as with the Add button. Remember that clicking Cancel will remove the Edit dialogue box 
without altering the customer name.

To delete a customer, firstly select the customer name from the list then click on the 
Delete button, you will be asked to confirm this decision by clicking on the button 
labelled Yes. If you delete a customer all programs associated with that customer will also 
be removed, this is an irreversible process so be careful.

2.3.15Exit
This option quits CNC Transfer. If there is unsaved work then you will be asked for 
confirmation, click on the Yes button to exit the program. It is advisable that you always 
exit the program before turning off your machine.

2.4Edit Menu
The Edit Menu consists of the following options:
1. Cut
2. Copy
3. Paste
4. Delete
5. Find
6. Find Next
7. Replace
8. Renumber
9. Header
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2.4.1Cut
This option will remove the currently highlighted text and place it on the Windows 
Clipboard, you can then use paste to put the text in a different position or even into a 
different program.

2.4.2Copy
This option will place the currently highlighted text on the Windows Clipboard, you can 
then use paste to copy the text to a different position or even copy it to a different 
program.

2.4.3Paste
This option will place any text on the Windows Clipboard at the current cursor position.

2.4.4Delete
This option will remove the currently highlighted text. Warning! The text will be lost 
forever so be careful when using this option.

2.4.5Find
This option opens the Find dialogue box, if any text is selected in the editor then this will 
automatically be put into the Text to Find box. You can edit this as normal, click on the 
OK button to begin the search. If the text is contained within the editor then the first 
occurrence of it is highlighted otherwise a message box will inform you that the text could 
not be found. To find further occurrences choose the Find Next menu option or press F3.

2.4.6Find Next
If you have already used the find option then this option will search for the next 
occurrence of the text you entered. Find Next will automatically loop around to the top of 
the editor when it gets to the bottom. If the Find menu option has not yet been used then 
the Find dialogue box will be shown (see Find).

2.4.7Replace
This option displays the Replace dialogue box, it is used to replace one piece of text with 
another. To use it simply enter the text you wish to remove in the box labelled Text to 
Find and the new text in the box labelled Text to Replace. Now click on either Verify or 
Global, Global will replace all occurrences of the first piece of text with the second. 
Verify allows you to see each occurrence of the text highlighted so that you can decide 
whether to replace it or not. 

When you click on Verify a further dialogue box is displayed, click on Replace to replace 
the old text with the new or Skip to go to the next occurrence. The Replace All button will 
replace all occurrences of the text from the current position to the end of the program. On 
both dialogue boxes the Cancel button removes the box from the screen.
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2.4.8Renumber

This option allows you to renumber a program. The First Value box allows you to enter 
the starting value for the first line of the renumbered program. The Increment box sets 
how much the number should increase by for each line of code. The Minimum Digits box 
allows the line number to be padded with zeros (for example setting Minimum Digits to 4, 
First Value to 0 and Increment to 5 would output the line numbers as 0000, 0005, 0010, 
0015, 0020, etc.).

The next section allows you to select which lines to add a number to, the first option 
labelled Renumber all lines, will put a number on all lines except for any exceptions that 
you select below it. The option labelled Renumber lines starting with: will ignore all lines 
except those that begin with the contents of the box that follows it (this is useful for 
programs who’s line numbers start with a letter e.g. entering N in the box would allow 
renumbering of line numbers such as the following: N0005, N0010, N0015, etc.).

Finally, the Restart numbering checkboxes allow the line numbers to be reset after a 
specific exception has occurred (this could be used to restart the line numbering after a 
blank line for example).

2.4.9Header
This box displays the additional information associated with each program and allows the 
user to edit this information. All of the boxes can be edited except for the Program Name 
and Customer Name boxes. Whilst editing in the Edit Header dialogue box you can use 
the Cut, Copy, Paste and Delete functions by pressing the key combinations listed next to 
the respective menu entries.
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2.5Transfer Menu
The Transfer Menu consists of the following options (some may be greyed):
1. Receive
2. Send
3. Edit CNCs

2.5.1Receive
This option will display the Receive dialogue box, this box allows you to get files sent via 
the serial port from a CNC machine.

You can use the File Name section of the dialogue box to select a customer name and then 
type or select a program name. You must also choose which CNC you are sending to. 
After choosing a CNC you can fill in any or all of the other boxes with further information 
about the setup used with this program. The Clear button will clear this information and 
allow you to start again.

To begin the process click on the OK button then tell your machine to begin sending the 
program. The Receive status dialogue box will appear this shows how many characters 
have been received so far. If you wish to end the process prematurely then clicking on the 
Cancel button will return you to the editor. When your machine has finished sending the 
program a message box should appear telling you the program has been properly received, 
if this does not happen then click on the Finish button to save the program you have 
received.

2.5.2Send
This option displays the Send dialogue box, it allows you to send the contents of the editor 
via the serial port to the selected CNC machine. You should use the Open command (see 
above) to load the desired program into the editor before using this command.

When you have selected the correct CNC you can click on the OK button to begin. Make 
sure that your machine is set to receive the program before clicking on OK. You should 
now be shown the Send Status dialogue box this shows how far through the process has 
gone, if you wish to stop the process prematurely then click on the Cancel button.

2.5.3Edit CNCs
This option shows a dialogue box very similar to the Edit Customer box. It operates in the 
same way allowing you to add, edit and delete CNC details.
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Clicking on the Add button opens the Add CNC dialogue box, it allows you to enter the 
relevant data about a particular CNC machine and to store that data for future use. First, 
enter a name in the box labelled CNC Name, this is compulsory. The other options can 
now be set to the required values, when you have finished click on the OK button to store 
the values permanently. You may remove the box without saving changes by clicking on 
the Cancel button.

Selecting a CNC Name followed by clicking on the Edit button allows you to change the 
current settings for that CNC. Clicking on delete allows you to delete a CNC file as with 
the Edit Customer box. To remove the Edit CNCs box from the screen click on the Close 
button.

2.6Options Menu
The Options Menu consists of the following options:
1. Data Location
2. Font Size
3. Text Colour
4. Background Colour

2.6.1Data Location
This option allows you to change the location where your CNC programs are stored. Enter 
the new pathname in the text box then press OK to confirm or Cancel to remove the box 
from the screen. Note this will not move the data directory only the location that CNC 
Transfer looks for it, if necessary you will have to move the data directory using Windows 
Explorer.
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2.6.2Font Size
This option brings up a submenu that allows you to select the size of the text displayed in 
the editor window.

2.6.3Text Colour
This option brings up a standard Windows colour box allowing you to change the colour 
of the text used in the editor window.

2.6.4Background Colour
This option brings up a standard Windows colour box allowing you to change the 
background colour of the editor window.

2.7Help Menu
The Help Menu consists of the following options:

2.7.1Registration
This option allows you to enter a registration code to enable the full version of CNC 
Transfer. A dialogue box will appear, in this box you will need to enter your Registration 
Name and Key, then click OK. Make sure you enter the data exactly as given to you. After 
registration this option gives the name of the registered user of CNC Transfer.

2.7.2About CNC Transfer
This option gives the version number of the program.
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3.Further Details
CNC Transfer uses its own directory to store programs and other relevant data. It would 
be a good idea to regularly make a backup copy of this directory using Windows Explorer 
or a special purpose backup utility. You should be careful not to delete this directory 
unless you want to get rid of all your programs and their associated data.

4.Trouble Shooting
If you have trouble transferring programs try using the following list to identify the 
potential problem.

The program is the correct length but the characters appear to be rubbish - Ensure 
you have selected the correct type of parity in the Edit CNCs box.

The program is not the correct length and the characters appear to be rubbish - 
Ensure you have selected the correct Transfer Rate, Data Bits and Stop Bits settings in the 
Edit CNCs box.

Nothing has happened - Check that the machine is connected to the correct port. Ensure 
you have selected the correct Handshaking options in the Edit CNCs box.
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